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Welcome to the latest edition of my monthly Final Cut Studio newsletter for March, 2009.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month, and past issues are not 
archived. Key articles from past issues are posted on my website for your 
reference. At the end of each year, all newsletters for that year are bundled and 
available in my store. All software references are to Final Cut Studio 2 unless 
otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, latest industry news, over 400 articles and tutorials to help you get 
the most out of Final Cut!
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WRAP-UP

WELCOME

I am really excited - we have some REALLY cool stuff to talk about this month.

Our recent UK tours were wildly successful - we had virtually standing-room only crowds in every 
city. At Broadcast Video Expo 2009, we did four presentations over three days in a room 
designed to barely hold 80, with over 135 people crammed in -- the aisles, around the edges, 
three people were standing in the audio booth -- it was amazing!

These seminars taught us a big lesson - there is a huge demand for Final Cut Studio training, but 
we need to make these seminars affordable. We are already working with potential sponsors to 
see how we can bring our costs down for our next tour.

In the meantime, I will be traveling to Dubai, UAE, at the end of April for a series of seminars, 
New Orleans in May, and back to the UK for a multiple city tour in August. I'll post specific details 
on all of these as we get closer to each event.

However, our BIG news this month is...

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ  
SELECTED OFFICIAL PODCAST OF 2009 NAB SHOW!

Through the hard work of our producer, Cirina Catania, Digital 
Production BuZZ has been selected as the Official Podcast of the 
2009 NAB Show this year!

We are delighted!

Starting April 18, we will be producing seven one-hour Digital 
Production BuZZ shows - one each day - highlighting the best of 
NAB. As well, we will be producing dozens of hourly NAB Show 
News Briefs during the entire show. These will be covering the 
breaking news at NAB.

IF YOU'D LIKE TO JOIN OUR CREW, WE NEED YOUR HELP! 

http://www.larryjordan.biz/nxltrs/wrapup
http://www.broadcastvideoexpo.co.uk/
http://www.digitalproductionbuzz.com/
http://www.nabshowbuzz.com/
http://www.nabshowbuzz.com/


To make this happen, we need to assemble a team of about 16 people - producers, reporters, 
audio editors, and production staff. We are essentially building a live radio news room for the life 
of the show.

If you would like to be part of this effort, and are already planning to be at NAB, send an email to 
Debbie@larryjordan.biz. She will let you know what we need.

As of today, we can only use volunteers. However, we are working to get sponsors and as soon 
as money starts coming in, I'll be able to pay you for your time.

We are already getting state-of-the-art equipment donations from leading companies. We will 
have a fully-functional, fully-digital, networked newsroom, built on the show floor and 
broadcasting during the entire show! 

If you want to play with some very cool toys, have an all-access exhibitor pass to the largest toy 
store in the world, and have your work heard by hundreds of thousands of people around the 
world, let us know. We are staffing this on a first-come, first-served basis. 

We'd love to have your help -- take a look here to see what we are doing! 

Also, if you'd like to syndicate our live news feeds direct from NAB on your website - for FREE! 
- click here and we will send you more information. 

[ Go to Top. ] 

REVIEW: TELESTREAM PIPELINE

NOTE: I've already written about the challenges in testing Pipeline in my Blog. 
(www.larryjordan.biz/blog). But the challenges are resolved and working with this 
product has been a great deal of fun.

At its simplest, Telestream Pipeline allows us to capture video over a network. But the way that 
Telestream has implemented this function within Final Cut Pro allows us to do things with video 
capture that we just can do any other way.

However, Pipeline isn't for everyone. If you are a one-person post house that owns exactly one 

mailto:debbie@larryjordan.biz?subject=I want to help at NAB!
http://www.nabshowbuzz.com/
mailto:srithip@larryjordan.biz?subject=Send me NAB syndication info!
http://www.larryjordan.biz/app_bin/wordpress/archives/504
http://www.telestream.net/pipeline/overview.htm


deck which is directly connected to your computer, then Pipeline is probably not a good idea. 
Starting at $1,950, it costs as much as a deck. Also, Pipeline is not designed for anyone working 
with tapeless media.

That being said, however, Pipeline has a variety of features that make it very attractive as your 
needs, or staff, expand.

I asked Telestream to send me their single channel standard-def unit to review. The two rack-
mounted units work the same way, but support up to four simultaneous video streams. I don't 
own and HD deck, so I was not able to test the HD version of Pipeline. 

KEY PIPELINE FEATURES

Pipeline is a network-attached device that allows you to share capture, output, and control from 
one to four video tape decks, or live sources, between multiple edit suites as easily as 
connecting to a server.

�●     Pipeline supports both SD and HD, though you need to purchase the appropriate 
hardware for HD.

�●     Pipeline is tightly integrated into Final Cut Pro, and encodes files which are fully 
compatible with Final Cut Pro.

�●     Pipeline allows you to automatically record video feeds based upon time of day.
�●     Pipeline even allows you to start editing a clip in FCP before the end of the clip has been 

captured.
�●     Pipeline is easy to install and use.

SETTING UP THE HARDWARE

Pipeline is a hardware device that can be placed anywhere on your network. You plug it into AC 
power, then connect up to three cables: network, SDI In, and SDI Out. 

First, you connect it to your network. Ideally, this should be to a gigabit switch. While a 100 
megabit network will work, it is not ideal. It is also important that Pipeline be on the same switch, 
or subnetwork, as your edit suites. 

Second, you need to connect your video sources to Pipeline using SDI cables. There are two 
ports on the back of Pipeline: SDI In and SDI Out. SDI, which stands for Serial Digital Interface, 
is a high-speed, fully-digital signal that contains video and multi-track audio from your deck or 
live feed. There are two flavors of SDI: SDI, which is used for standard-def, and HD-SDI, which is 
used for high-def.

NOTE: Due to the bandwidth SDI requires, be sure to use cables rated for SDI 
video. Standard video cables may not work reliably. 

Third, RS-422 is used to remotely control the deck. This is a 9-pin connector that goes from your 
video deck to the Pipeline. While live feeds won't have, or need, remote control, being able to 
control your deck from Pipeline is essential. (My deck didn't have RS-422 control, but most 
higher-end decks do). 

Remote control means that you can click a button in the Pipeline interface and have the deck 
respond appropriately - just as a FireWire-controlled device does in the Log and Capture 
window. While it would be nice for Pipeline to also use FireWire to control less-expensive decks, 
at this point Pipeline only supports RS-422.

Installation of Pipeline software is from a CD. It worked perfectly and took less than two minutes. 
It installs two applications: Pipeline Porter and Pipeline, as well as a new menu item inside Final 
Cut Pro. More on all of these in a minute.



PROBLEMS WITH SDI

My first big road-
block proved to be 
SDI -- and this 
wasn't the fault of 
Pipeline.

I decided to test 
this unit using my 
trusty Sony DSR-
11 DV deck. 
However, it only 
has S-Video and 
Composite output. 
So, I contacted 
the folks at 
Blackmagic 
Design for a 
couple of their 
mini-converters. 

They sent me two 
mini-converters:

* Analog-to-
SDI 
* SDI-to-Analog

While I really like how Blackmagic has packaged this in environmentally-friendly boxes -- and the 
way they handle power conversion between all the different power systems on the planet is 
absolutely brilliant - I had a problem. 

These little boxes, about the size of a package of cigarettes, convert signals from one format to 
another. Well, that's what they are SUPPOSED to do. But, in point of fact, it took me almost a 
week to discover that the Analog-to-SDI mini-converter has a bug in it that prevents it from 
working properly.

The specific problem is that the converter determines its settings from a small DIP switch on the 
side. In the current version, when the unit is powered up, it ignores the DIP switch setting, which 
means that everything gets reset.

I contacted Blackmagic Tech Support about this issue who then sent me the following note:

You are describing a known bug. We are in the process of fixing this issue with a 
future release. In the mean time, the work around is to plug and unplug the unit 
and reset the number 5 jumper to the desired output. 

The bug is basically that the setting doesn’t get retained. So if you set it to 
composite, then unplug the unit, the unit doesn’t “remember” that it’s set to 
composite even though the switch is down. The workaround is to have it set 
jumper 5 back to component (default setting), plug the unit back in, then flip the 
jumper 5 to composite. Then until you unplug the unit, it’ll stay at composite. Yes, 
a little annoying but the newer manufactured ones don’t have this issue. The ones 
that do have this bug will be fixed when we release software to update the unit.

http://www.blackmagic-design.com/products/miniconverters/
http://www.blackmagic-design.com/
http://www.blackmagic-design.com/


While I was never able to get S-Video to SDI conversion to work, after a lot of experimentation I 
was able to get a reliable, clean composite signal by turning off all DIP switches except switch 4. 
At which point, everything worked great. However, this DIP switch setting does NOT match the 
printed instructions on how to properly configure the converter.

Because of these problems, I can't recommend this mini-converter for general use until 
Blackmagic Design makes the DIP switch settings stable, even after re-powering the device, with 
settings that match the documentation printed on the package.

The SDI-to-Analog mini-converter seemed to work fine. 

USING PIPELINE IN FINAL CUT PRO

The easiest, and coolest, way to use Pipeline is within Final Cut Pro. Here's how.

After installation, a new menu choice is added to Final Cut Pro. Go to File > Import > Pipeline.

The Pipeline Selector window appears. If you have more than one port on your Pipeline, or if 



you have more than one Pipeline, this window allows you to choose which Pipeline you want to 
work with. 

Each Pipeline is automatically discovered, which means as long as the unit is powered up and 
on the same switch as your computer, your computer will find Pipeline automatically.

Select the Pipeline you want to use, pick the Codec you want it to use to convert your media into, 
and select either 2 or 4 channels of audio.

IMPORTANT: Before leaving this window, we need to set Preferences. Click the 
Preferences button to open the Preferences window.

Most preference settings are fine EXCEPT the Scratch Disk. Just as you need to capture media 
to a second drive for Final Cut, you also need to do the same for Pipeline. Unfortunately, also 
like Final Cut, Pipeline defaults to setting your preferences in the Home directory of your boot 
drive - just about the worst place possible.



Change scratch disk locations by clicking the Scratch Disk popup menu and re-pointing it. What I 
did is create a new folder on my second drive called Pipeline Scratch and pointed my scratch 
disk there.

NOTE: Something weird happened as I started using the unit. The scratch disk 
changed from directly pointing to my second drive to pointing to the scratch disk in 
the Volumes folder. Volumes is an invisible folder (which is why it is grayed out) on 
your boot drive that stores a list of the hard disks attached to your system. For 
some reason, the scratch disk got re-pointed so that all my video was capturing to 
a folder on my boot drive. For this reason, before starting any capture, it is 
important to reconfirm that your scratch disks are properly pointing to your second 
drive.

Once you've selected the Pipeline you want to use and configured your Preferences, click OK.

This is the main Pipeline window. Essentially, think of this as Pipeline's version of Log & Capture. 
Everything you normally do in Log & Capture, you can do here -- though the interface is 
somewhat different.

For instance, I want to capture some snowboarding footage shot by Standard Films in Lake 
Tahoe.

http://www.standardfilms.com/


This dialog appears if you don't have remote control over your deck. Again, for live feeds this 
isn't a problem, but Pipeline warns you anyway.

Your keyboard shortcuts for deck control, setting Ins and Outs, and previewing are exactly the 
same as Final Cut; again, provided you have remote control over your deck.

NOTE: One of the neat features in Pipeline is that the Preferences window allows 
you to create your own keyboard shortcuts, although the default set matches the 
ones Final Cut Pro uses.

There are two ways you can capture a clip:

* Logging each shot with an In and Out and building a batch list. 
* Capturing each clip individually.

To capture a clip, press the red Record button. Pipeline instantly starts recording whatever video 
is playing from the deck or live feed directly to your hard disk.

 

While a clip is being captured, a yellow "recording" icon appears. Once the capture is complete, 
the tag changes to a green checkbox.



As you continue capturing clips, the list of clips grows.

Double click the icon of any clip to display the metadata window. This allows you to enter the 
same information you add during Log & Capture. However, unlike Log & Capture, the metadata 
is stored in the QuickTime file itself, not just in the Final Cut Browser.



Here's the cool part. Once you are done capturing clips, click the Import button and all your 
Pipeline clips are instantly imported into Final Cut's Browser!

At that point, you edit them as if you had captured them using Final Cut itself.

NOTE: Once you've captured an image, you can't preview it in Pipeline. You need 
to move the video to Final Cut to review your shots.

One thing that struck me was the quality of the images. Even though I was capturing via 
composite video, the images were really clean and sharp. Telestream has done a very nice job 
of maintaining image quality.

Very, very cool!



USING PIPELINE PORTER

Pipeline Porter is a simple application that works similarly to the Log & Capture window in Final 
Cut Pro, without requiring the use of Final Cut.

From the Applications folder, open Pipeline Porter. Clicking Import opens the Pipeline Selector 
which we first saw in Final Cut Pro, where you pick which Pipeline stream and various formats.

NOTE: Something that I noticed is that Pipeline does not remember scratch disk 
settings all the time. Make a point to ALWAYS check scratch disk settings before 
starting capture. 

Once you've configured Pipeline, click OK to open the import window. At this point capturing 
clips is the same as we have already covered. However, when you are done capturing, you will 
need to import the clips into Final Cut manually.

The Pipeline Porter is an excellent way to have an assistant, on a system where Final Cut is not 
installed, log, capture and add metadata to clips, without tying up your Final Cut system.

RECORDING BASED ON TIME OF DAY

One of the real strengths of Pipeline is its ability to capture media based on time of day. This 
provides two key benefits: unattended recording based on time of day, and the ability to start 
editing a clip while the end of it is still recording. (This last point is truly a time-saver!)

Say you need to record a live feed, or program, starting at exactly 10:00 AM. To set up 
scheduled recordings, we need to run another Telestream application: Pipeline.



The Pipeline main window provides a series of pop-up menus across the top where you can 
select which Pipeline to use, the video and audio formats, and a variety of other settings.

NOTE: This application does not remember existing scratch disk settings 
whenever you create a new schedule, nor does it access your Pipeline preference 
file. By default, it stores media in your home directory. This must be changed to 
your second drive to prevent problems with either recording or playback. 

To change the storage location, double-click the name of your hard disk in the upper left corner, 
and point it to your second drive. Again, I'm pointing it to the same scratch disk folder I used 
earlier: Pipeline Scratch.



Here's another critical step. You need to set Pipeline to recognize the clock you want to use. 
Leaving the clock in its default setting of AUTO means that Pipeline zeros the timer when you 
start the application. You must set the clock to read either in-coming RS-422 timecode from the 
feed, or your computer clock, depending upon which is the most accurate, in order for the 
schedule to record properly.

In this case, I'm using the computer as my master timecode and scheduling clock.

To add a new clip to your recording schedule, you have two options:

1) Click the Add New Clip button near the top of the window, or, 
2) Drag directly on the schedule itself.

By default, clicking the Add New Clip button creates a new clip at midnight of the current day. 

To set the recording time, drag out a blue box in the schedule window. If your recording is 30 
minutes or longer, just drag the top and bottom of the blue bar to the start time and duration you 
want. However, the shortest recording you can create by dragging is 30 minutes.



To set recording times for something shorter, double-click the blue box for the recording and a 
pair of clocks pops up. This window allows you to precisely set the recording time and add labels 
and colors to the clip.

Setting the time using the clocks is trickier than I expected. You can't drag the hands of the 
clock, nor can you change the Start time to be more than four hours different from the Ending 
time.

If you get carried away trying to set the clocks, you'll see this error message.

So, when I have something short to record, the easiest way I found to set the time is to set the 



Ending time to the duration you need, then click the Link button so the two clocks stay in sync, 
then change the Start time. Its a bit awkward, but works OK.

Once you've established your recording times, save the schedule, and click the red record button.

Pipeline goes into waiting mode until the appropriate time rolls around...

... then shifts automatically into record mode, saving the file with the name you specified in the 
location you requested.

EDITING BEFORE CAPTURE IS COMPLETE

This is the amazing part.

Let's say you need to start editing something before capture is complete. Maybe its a news cast, 
or a long, long recording. Under normal conditions, that is, using Final Cut, you can't do anything 
with a clip until capture is complete.

BUT, using Pipeline's ability to schedule a recording, you can!

Here's an example.



I've scheduled a five minute recording -- I could have used any amount of time, even a couple of 
hours, but I want to get this review finished. Pipeline has started the recording.

What it did it allocate space on my hard drive as though it has already finished the entire 
recording. So, from the point of Final Cut, it thinks the recording is complete, even though 
Pipeline is still adding new data to the file.

When I load the clip to the Timeline, the entire five minute clip is loaded, even though I've only 
recorded the first minute or two.



But, when I go to play it in the Canvas, Final Cut plays everything that has been recorded up to 
that instant, EVEN THOUGH the rest of the clip is still being recorded! This allows me to start 
editing my sequence without waiting for the rest of the recording to be complete.

I have never seen this feature anywhere else. It is an amazing time-saver!

CONCLUSION

Pipeline is fun to play with. Once set up it is very easy to use. The quality it creates is amazing 
and I continue to discover new ways to use it. Its tight integration with Final Cut Pro makes it 
especially worthwhile.

My concerns about Pipeline are three:

1.  If your video sources don't provide SDI output, converting your video into SDI requires 
gear not provided by Telestream

2.  Pipeline does not support machine control or timecode via FireWire
3.  Pipeline seems to have an inability to maintain scratch disk settings as you switch 

between its various applications.

However, if you need to share decks or video sources among multiple editors, or edit video 
under extremely tight deadlines, Telestream Pipeline makes the process flexible, fun, and with 
extremely high-quality.

UPDATE - March 15, 2009

Lowell Kay sent in the following questions:

Sienna and Picture Ready have been accomplishing what Pipeline has presented 



  
  
  
  
  
  
  
  
  
  

for about 3+ years. The system only records 1 SDI signal to a computer at a time, 
but you can have multiple servers accomplishing this task. Editing on the timeline 
while capturing has been available.

What was not clear to me from your review, does Pipeline allow you to capture at 
uncompressed or does it limit you to the bandwiths that can be transferred through 
Gigabit? 

What is the maximum video streams that you can record with one unit and if you 
have multiple units, how many can you have running concurently? If you have 
multiple units, can they be synced from the software to start and stop recording 
from one button? 

If you are running from a clock, will it sync to an NTP server or clock and be frame 
accuracte or is it just near the TC? I am asking this question because television 
stations need it to be more than just close. When you did your tests, did you place 
a TC window on the video that you were supplying and did it return with the same 
code as what was on the video?

Larry replies: Lowell, thanks for asking. Here are some of your answers. 

Picture Ready costs $500 more than Pipeline and requires a Dongle. Pipeline will feed video to 
any computer on the network, all it requires is the drivers to be installed. 

Pipeline has three hardware versions:

* Single Channel SD 
* 4 channel SD 
* 4 channel HD

Due to current limitations of QuickTime, only one channel can be captured per computer. 
Pipeline does not require a server - instead it compresses inside the unit and feeds compressed 
signal to whatever computer needs it.

Since it captures at real-time, you are limited by the bandwidth of your network. It does, however, 
capture to ProRes, among several other formats.

I don't know about multiple unit sync or timecode accuracy. I was not able to test with external 
timecode because I don't have a timecode generator here. 

[ Go to Top. ] 

LARRY RELEASES FIVE NEW VIDEO TUTORIALS!

I've just released five more short, focused tutorials on Final Cut Studio. These are:

* Improving File Management in Final Cut Pro using Adobe Bridge 
* Using Media Manager to Archive Final Cut Pro Projects 
* Importing and Exporting EDLs 
* Creating a Variable-Speed Clip in Final Cut Pro 
* Using the Time-Stretch Tool in Soundtrack Pro

You can find the complete list of tutorials here.

http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=99
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=100
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=101
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=103
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=102


Since we released these a few months ago, I have enjoyed watching which ones have proved 
the most popular - because that helps me determine how to modify my seminars and training.

In case you are curious, my top two most popular tutorials are:

* Retouching Video in Photoshop 
* Preparing Still Images

But with over two dozen to choose from, and priced at only $4.99, there's sure to be at least a 
couple that can help you solve some of the problems you're having.

By the way, if you have ideas for training you'd like to see, drop me a note.

[ Go to Top. ] 

TECHNIQUE: CAPTURING 32 kHz AUDIO

One of the questions I get asked frequently is how to solve a problem where audio is slowly 
drifting out of sync, or an error message appears saying that the capture or sequence settings 
don't match the audio rate.

In all these cases, the problem is the audio sample rate used by your camera.

While virtually all professional cameras record audio at a 48 kHz sample rate (sometimes called 
16-bit, though this number has nothing to do with audio bit-depth), most consumer cameras are 
preset to record audio at 32 kHz. There are some marketing benefits to this setting, but no 
technical or audio benefits to recording at 32 kHz.

NOTE: The sample rate determines the frequency response of the audio our 
cameras record. In general, the higher the sample rate, the higher the fidelity - or 
accuracy - of the sounds being recorded. A 48 kHz sample rate has a frequency 
rate that exceeds the range of human hearing, while a 32 kHz sample rate is not 
quite as high a quality. 
 
While bar fights have broken out over how much we should worry about this, my 
general feeling is that recording your audio at 48 kHz generates professional 
results and is the sample rate FCP is optimized for. If possible, set your camera to 
record all audio at 48 kHz. Then, read the rest of this article on how to capture the 
material that you've already shot.

Unfortunately, once audio has been recorded, you can't change the sample rate on the tape. 
Instead, we need to change the way Final Cut processes the audio.

Just as you need to tell Final Cut what video format you are using, you also need to tell Final Cut 
the audio settings. Fortunately, the audio settings are few and easy to change -- if you know 
where to look.

And that is what this technique is about.

First, take a look at the menus on your camera. If the audio is set to record at 32 kHz or 12-bit, 
then, you'll need to make these adjustments. Or, if you have a friend with this problem, share this 
article with them. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=77
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=87
http://www.larryjordan.biz/training/online_tutorials.html
mailto:larry@larryjordan.biz?subject=Tutorial ideas


If your camera says it is recording audio at 48 kHz, or 16-bit, don't touch a thing. Your camera 
and Final Cut are perfectly suited to one another.

But, if these don't match there are two settings that need to be adjusted in Final Cut so that it will 
process your audio properly:

1. Capture setting - this determines how Final Cut will capture, or record, your 
audio. 
2. Sequence setting - this determines the audio setting of your sequence. If they 
don't match, FCP will need to render you audio. When they do match, FCP will 
play your audio perfectly.

CHANGING THE CAPTURE SETTING

To change the capture setting, go to: Final Cut Pro > Audio / Video Settings.

There are five tabs across the top. We will be working in tab number 2 and 3.

Click the Capture Preset tab to select it.

In the list below it are all the different video formats that FCP supports. Notice how almost all of 
them list the audio as 48 kHz?

NOTE: The little lock icon, on the right side, indicates this is one of the essential 
presets shipped by Apple. The lock means you can't delete it. While this is not, 
completely, true, in general, you don't mess with these locked settings. Instead, 
we will duplicate the setting and modify the duplicate.



Click the Duplicate button.

In the setting screen that appears, change the title so that it reflects this is a 32 kHZ setting. 
While this is just a label, make it clear enough so that you will know to select this again if you 
need it in the future.

The real work is below, in the QuickTime Audio section. Change this from its default setting of 
48 kHz, to 32 kHz. Then, click OK. 

That's it. You've told FCP to capture all audio at 32 kHz.

NOTE: Here's the trap. As long as you capture your audio properly, FCP can 
handle 32, 44.1, and 48 kHz audio on the same Timeline with no problem. But if it 
is NOT captured properly, FCP can't fix it afterward. That's why this setting is so 
important.

 

Now, whenever you need to capture 32 kHz material, just select the setting you just created. 
(The check-mark to the left of the title indicates that this is the currently active capture setting.)

You could stop here. But, if you want FCP to play 32 kHz audio on the timeline without rendering 
it, you'll need to change the Sequence setting as well.

NOTE: Remember! Changing a preference setting has NO affect on any existing 



sequences or clips. You must change the preference setting BEFORE capturing 
any clips, or creating a new sequence. Once a sequence has been created, 
changing preferences does nothing.

 

Click the Sequence Preset tab to select it.

Duplicate the video format that you want to set to 32 kHz.

 

Change the name of the preset so you can easily find it again.

 

Then, in the lower right corner of the window, change the audio setting from 48 kHz to 32 kHz. 
Click OK to save your work.

SUMMARY

Now, when you want to capture 32 kHz material, change to the Capture setting you just created.

When you want to edit 32 kHz material to your timeline without FCP needing to render it, change 
to the Sequence setting you just created.



EXTRA CREDIT

If you need to adjust an existing sequence so that it will play 32 kHz audio without rendering, 
open the sequence you want to change into the Timeline.

Be sure the Timeline is selected and choose Sequence > Settings.

 

In the lower right corner, change the audio setting from 48 kHz - the default - to 32 kHz. At which 
point, all 48 kHz audio will probably need to render, but all your 32 kHz material will play perfectly 
without rendering.

NOTE: Changing the audio setting of the sequence is simply an issue about 
rendering. FCP will properly handle 32, 44, and 48 kHz - however, depending 
upon your sequence settings, it may need to render audio files that don't match 
the sequence setting.

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ IS NOW ON wsRADIO

We are now broadcasting the highlights of Digital Production BuZZ each month on wsRADIO. 
The Internet is becoming the future of broadcasting. Now, with wsRADIO and the BuZZ, you 
have one more way to stay current.

The show is updated the second Thursday of each month.

March's show, posted yesterday, features highlights of our recent overseas tour: 
* Ken Hay, CEO of Scottish Screen, Glasgow, Scotland 
* Simon Daniels, CEO of Design for Life, Dublin, Ireland 
* Carl Grinter, Director, Business Development of Rushes Post, London 
* Kieron Seth, Managing Director, Broadcast Video Expo 2009, London 
* Andy King, Head of Technology of the BBC, London

The February show, posted Feb. 12, featured a summary version of our Special Report - The 
State of Blu-ray, with myself and Bruce Nazarian.

You can learn more about the series here.

NOTE: Their website does not display well in Safari. It will look better using Firefox.

[ Go to Top. ] 

http://www.wsradio.com/internet-talk-radio.cfm/shows/Video-Production-Radio.html


TECHNIQUE: ADDING REVERB TO AN AUDIO CLIP

I got an email recently asking me how to add reverb to an audio clip in Final Cut. The problem 
they had was that the reverb cut off as soon as the clip ended.

The trick is that you need to have the effect of the reverb filter continue after the clip ends. It 
requires nesting. Here's how.

 

Edit the clip you want to add reverb into the Timeline. Move it to a different track to separate it 
from other clips. Then, add a 3-5 second audio slug after the end of the clip.

Select both the audio clip and the following slug and choose Sequence > Nest items.

 

Name the nest something that will help you remember it. In this case, I called it Clip with 
Reverb, and click OK.



 

FCP has replaced your original clip and slug with another sequence, called Clip with Reverb. 
This process of putting a sequence into another sequence is called nesting.

What nesting allows us to do is to treat a group of clips (either audio or video) as a single clip. In 
this case, to apply a reverb filter so that when the sound ends in the clip, the reverb will continue, 
or ring out, over the slug.

The last step is to apply Effects > Audio Filters > Final Cut Pro > Reverberation.

NOTE: To adjust the amount of reverb, OPTION+double-click the sequence to 
load it into the viewer. To make changes to the audio clip or the slug, double-click 
the sequence.

 

Settings for this filter that I like are to adjust the effect mix to around 10 and the type to either 
Hall (Large) or Thin Plate (Long).

As with any effect in Final Cut, experiment until you find the settings you like.

[ Go to Top. ] 



MONITORING HD VIDEO

Maly Gabor sent me the following question:

Why do I need a card like Blackmagic Design Intensity Pro to output my video on 
and LCD TV? When it comes to monitoring your work on an LCD TV, why can't I 
just connect my Imac to and LCD TV through a DVI-HDMI cable and achieve the 
same results? I read all the great stuff about these cards but this simple question 
is not answered anywhere (or at least I have not found it).

Larry continues: This struck me as a really good question, so I sent it off to Dan May, president 
of Blackmagic Design/US, for an answer. Dan wrote:

The trick with DVI output of your graphics card is that it is going to give you the 
‘Preview’ quality that Final Cut is playing back for you and this might not be 
consistent. The output of the DVI is actually always going to output an full raster 
and full frame rate, but the data it is being handed may not. When you have a clip 
that is just playing back in Final Cut Pro then you should likely be getting all the 
data out the DVI output to the monitor. However if you start working with 
transitions, color corrections, and complex or compressed files then often times 
Final Cut Pro will play back in real time, but what you see on your PREVIEW 
monitor is scaled back (be it line scaling and/or lower frame rate). This is what is 
actually being handed to the Graphics card and then scaled out to the monitor. 
Think of it like taking a large BMP file that is being saved to a smaller resolution, 
then opened and resaved as a higher resolution. There is data being lost in the 
final image you are seeing. Obviously how beefy your system is will determine 
how much real time you are getting, and thus determine how often your going to 
run into that non full raster PREVIEW that may not look up to par.

When you are using a Blackmagic card what actually happens when you add an 
effect is that the effect is processed and then output in full raster and full frame 
rate. So as long as FCP can play it back what you are seeing is what you are 
getting that out to your monitor as it should be seen, not as a preview. Even when 
clips can’t play back (or say such as the case in After Effects) what you are 
scrubbing through is still full resolution high quality video.

So look, if I’m just doing a video for my wife's birthday this year does the DVI 
output suffice? Yes it probably does (assuming your wife isn’t a colorist I suppose).

If I’m doing an edit that is going to go be heavily edited with color corrections and 
titles, someone’s paying for this or it is going to be critically viewed then IMHO it is 
worth getting that consistent high quality output.

Larry replies: Thanks, Dan, for filling us in.

[ Go to Top. ] 

UPDATED FINAL CUT ASSISTANT

I wrote about Final Cut Assistant, from Peake Professional, a while ago. However, at the time it 
was Leopard-only and had several rough edges. 

Since then, however, they've created versions for both Tiger (10.4) and Leopard (10.5) and 
polished up the interface. They just sent me a note saying they've updated it to a new version, as 
well. 

http://www.blackmagic-design.com/
http://www.peakeprofessional.com/home/Final_Cut_Assistant_Online_Help.html


If you are looking for a utility that can help you manage Final Cut Pro, take a look at the Final Cut 
Assistant.

Its shareware - and worth a donation.

[ Go to Top. ] 

READER MAIL

NOTE: I am waaaay behind in my Reader Mail - I have over 100 letters I haven't 
had time to share with you. Let's see how many of these we can get through this 
month. I'm hoping to put out a supplementary newsletter soon to help me catch up.

[ Go to Top. ] 

DELETING AN FCP PROJECT

Daniel writes:

I bought your “Final Cut Pro 6” series of DVD’s from Lynda.com. 
 
How do I delete a project in Final Cut Pro 6? 
 
I could not find such a simple answer. Would you help me?

Larry replies: You don't delete a project from within Final Cut. Simply locate the project file in the 
Finder and drag it into the Trash.

[ Go to Top. ] 

HARD DRIVE TRICKS

Lee Berger writes:

On a recent Digital Production BuZZ, you suggested two internal drives for a 
MacPro, one for the system and applications, the other for data. Let me suggest 
another configuration using two internal drives that I use. I put the system, 
applications and all data on one drive. The other drive I dedicate for Time Machine 
backups. That way if the main drive fails I can restore everything from the Time 
Machine drive and be up and running very quickly. 

By the way, I learned a neat trick. If you have another Mac you can connect it to a 
problem Mac via firewire and mount that machine's drives. Hold down the "F" key 
while booting. In this way I was able to recover all my data files from the MacPro 
(the drive that would not boot) prior to doing the clean install. Of course this only 
works with a drive that has recoverable files. I guess in my case there was a 
corruption in the boot sector.

http://www.peakeprofessional.com/home/Final_Cut_Assistant_Online_Help.html
http://www.peakeprofessional.com/home/Final_Cut_Assistant_Online_Help.html


Larry replies: Thanks, Lee, for sharing these ideas.

[ Go to Top. ] 

ITS NOT YOUR DRIVE, ITS YOUR POWER SUPPLY

Cal Deal writes:

You should let my fellow readers know about this, because many may have 
experienced "drive" failures that were actually power supply failures. Heaven only 
knows how much data has been "lost" because the users did not realize the true 
nature of their problem.

As you can see in the photo below, this has happened to me repeatedly: A drive 
fails to mount, the "blue light" is blinking instead of steady, and disk utility cannot 
access the drive. It's a goner, right? Wrong!!!!! I test the unit by attaching a power 
supply from a WORKING LaCie drive. In the vast majority of cases, the drive has 
started right up and mounted fine.

Sometimes the power supplies begin to fail by HISSING! One day when I was 
upset about this, I put a video on YouTube, you can see it here. 

So I think you would do a service to your readers by telling them to check the 
power supply first before they give up hope on their precious data!

Larry replies: Consider it done.

[ Go to Top. ] 

http://www.youtube.com/watch?v=tTZ7EvSJnng


REMAPPING KEYBOARD SHORTCUTS

Jeffrey writes:

I always used the F1 and F2 keys to add or subtract 3 dB at a pop to audio clips, 
which I found very handy. I don't remember mapping them (wouldn't know how), 
they just seemed to work. But I trashed prefs a week ago because of instabilities 
in the program, and everything works fine now -- but those F keys no longer do 
anything. How do I make them functional again?

Larry replies: You'll probably need to remap your keyboard shortcuts. To do so, choose: Tools > 
Keyboard Layout > Customize.

Here's an article that provides more details.

[ Go to Top. ] 

MORE ON KEYBOARD SHORTCUTS

Daniel Garcia writes:

I want to send you a great tip for Macbook Pro FCP editors that have the F9 and 
F10 problem in your "More on keyboard shortcuts" section.

I don't want to have to deal with the Fn key so I use a free app called FunctionFlip 
that lets me choose which keys I want to act as F[#] and which I want to retain the 

http://www.larryjordan.biz/articles/lj_shortcuts.html
http://kevingessner.com/frog/projects/functionflip/


media functionality. 

I have an external keyboard at home, but when I edit outside i just enable it for the 
F5-F10 keys and leave the monitor brightness and volume keys as original.

Larry replies: Cool - thanks for sharing this with us.

[ Go to Top. ] 

AUDIO SAMPLE RATE FOR THE WEB

Mary Merkle-Bargmann writes:

Can you recommend a sample rate to use for web use? I am exporting from FCP2 
using Flip4Mac to wmv files. I like the quality of the video but I am not sure if I 
should be using 44.1 khz or 48.0 khz settings? Is the difference in the file size or in 
sound? For example, is the difference like listening to AM vs FM?

Larry replies: Mary, bar fights have broken out over this topic. But, since you ask, here is my 
opinion.

If you have one person talking, always output mono. Outputting stereo files doubles your file 
size. Unless you need the stereo effect, mono is always a better choice.

22,010 sample rate: Excellent for spoken word or narration. 
32,000 sample rate: Good for mix of narration and music 
44,100 sample rate: Excellent for music and narration 
48,000 sample rate: No significant improvement over 44 kHz for the web

[ Go to Top. ] 

MOVING ON STILLS

Don Smith writes:

I was doing a series of stills back to back. My workflow was to lay in two stills and 
set keyframes at their IN and OUT points. I then put a cross dissolve between 
them. My purpose was to have the outgoing still in motion and the incoming still in 
motion as the dissolve happened.

However, after applying the dissolve, FCP MOVED THE OUTGOING AND 
INCOMING KEYFRAMES between the two stills! Rats! The result made me look 
like I was a beginning editor; the motion of the first still stopped, THEN the 
dissolve began and completed into the NOT-moving second still, and only then did 
the motion of the second still begin.

Below, is the little picture of the two stills with the keyframe of the incoming still 
shown in the big picture. The second little/big pictures shows that I've applied a 
cross dissolve and you can see that the IN keyframe is in a different location than 
in the upper big picture.



I could put in the dissolve first and then set the keyframes, but in a cross-dissolve 
you can't see what the picture is doing at that point.

Am I missing a preference or does FCP really think I'm stupid?

Larry replies: FCP certainly does NOT think you are stupid! But it can drive you nuts.

FCP is not moving the keyframes, it is adding handles to accommodate your dissolve.

The best way to handle this is to checkerboard your images between V1 and V2, then add 
handles for your transitions THEN add the transitions. That will work perfectly.

Here's a video tutorial I recently created that explains this in a lot more detail.

UPDATE - Mar. 15, 2009

Cal Deal sent in this alternative:

If you're doing more than a few images in a slide show, strongly consider Photo to 
Movie. Made by LG Graphics, it's a great little program that does nice transitions, 
eases in and out, adjusts to the length of music and so on. You can put a 
document in it and pan and zoom around a single document. You can also add 
type. 

Export the movie to Quicktime and voila! Well worth the $50 it costs. 

Larry replies: Thanks! 
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CREATING STILLS FOR HD

Alexey Tolchinsky writes:

I am a photojournalist and work now on multimedia galleries of my work. I have a 
short technical question on importing photos in HD video formats in FCP Express.

My goal is to preserve the image resolution sufficiently to present the gallery in HD 
quality. There is no video, just still images and sound. I don't want to crop, and will 
live with letter- and pillar-boxing.

Larry replies: Alexey, since you are on FCP Express, use the Apple Intermediate Codec (AIC). If 
you were on Final Cut Pro, I'd suggest using ProRes 422 HQ.

Since you want to post these to the web, I'd suggest working in 720p. This creates higher-quality 
images than standard-def, but keeps files sizes smaller and easier to view than 1080i.

If you don't want to move on your images, create everything at 1280 x 720 -- always at 72 dpi. If 
you want to do moves, create your images at 3200 x 1800. This allows you to do pans, tilts, and 
zooms. You can magnify an image up to 2.5x.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=74
http://www.lqgraphics.com/software/phototomovie.php
http://www.lqgraphics.com/software/phototomovie.php


Don't make any image bigger than 4,000 x 4,000 pixels. 

NOTE: By the way, the numbers for 1080 images are 1920 x 1080 (again, at 72 
dpi). For moves, use 3,840 x 2,160. The frame rate does not affect image size. 

- - -

PRORES vs P2 (DVCPROHD)

Max Aguilera-Hellweg writes:

Here's a question about Apple ProRes and P2 HD workflow. When log and 
transfer (capturing) P2 HD to FCP, do you capture in Apple ProRes, or do you 
capture in the native codec, then make a apple ProRes conversion to edit in? 

Larry replies: When I shoot P2, I edit natively in P2 (DVCPROHD). There's no significant benefit 
to converting to ProRes, unless I need to combine media from a variety of different formats into a 
single project.
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MORE ON XDCAM

Mark Krichever writes:

I have a question that might be of interest for many who own XDCAM cameras. In 
order to produce HQ .avi video using XDCAM (Sony PMW EX1) and FCS 2 what 
would be your recommended workflow? And what is your recommendation for 
workflow related to production of SD DVD of the best possible quality.

Larry replies: Since Final Cut can not, natively, edit or output AVI files, you need to convert an 
AVI file prior to bringing it into Final Cut. MPEG Streamclip is a good choice to do so.

However, there's a better way. Do a Google search for Sony XDCAM Transfer - the current 
version is 2.5.1. This free software allows you to preview and import XDCAM HD and EX footage 
directly into Final Cut Pro.

It requires a minimum of FCP 6.0.3 and OS X 10.4.11.
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AUDIO IN SNAPZ

Craig Reed writes:

Excellent work keeping the newsletter going when so many other things are 
probably nagging for your attention.

With regards to your feature on using SnapzPro clips in Soundtrack Pro, we use 
SnapzPro all the time, but more commonly with BIAS Peak than Soundtrack Pro. 

http://www.squared5.com/


Peak registers the incoming audio tracks from a Snapz screen movie (following 
the first video track) as: 
Track 2 - Stereo pair from the Mac Audio capture 
Track 3 - Stereo or Mono track from your microphone

Of course it may depend on what interface you are using for a mic input. I am 
using a USB mono headset boom mic from Plantronics.

Either way, you can set what format you want the Mac Audio track and the 
Microphone Audio track to be within the SnapzPro dialog before you save the 
movie. When I set my mic track to Mono, it shows up in both Peak and Soundtrack 
Pro and FCP as a Mono track.

Larry replies: Craig, thanks for writing. I agree that you can modify how the tracks are recorded, 
but you CAN'T modify the order of the tracks. In other words, if you have both computer sounds 
and voice narration, the narration will always be recorded to tracks 3 & 4, and this causes a 
problem with the current version of Soundtrack Pro.

I recently got a copy of Telestream's ScreenFlow and will test it to see if it gives me more 

http://www.telestream.net/screen-flow/overview.htm


flexibility. I'll have a report on it in a future newsletter. 
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H.264 COMPRESSION

V.C. Wolff writes:

Could you explain what is meant by the "scalability" of h. 264 codec and how it 
benefits us with out put.

Larry replies: Scalability means that the codec, not your compressed video, has the capability to 
encode for the very small file sizes demanded by the web, as well as the very high quality 
images demanded by network television and digital projection.

So it is the codec, not the video compressed by the codec, that is scalable; you could also use 
the word "flexible." The benefit to us is that once we learn how to tweak the codec, we don't have 
to learn the same stuff for different codecs.... learn once, use multiple ways.
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MISCELLANEOUS THOUGHTS

Jonathan Pienaar writes:

In your January issue, Louise Fleming wrote:

In FCP my import [i.e. pictures & text] are sharp/in focus in the 
Viewer but go soft in the Canvas?

I have found that graphics will play in realtime in FCP when the RT menu (top left 
corner of the Timeline) is set to Unlimited RT, but be soft until rendered. It's just 
one of those silly but obvious things that she may have missed.

Secondly, when images flicker or shimmer, especially video freeze-frames, often 
FCP's built-in De-interlace filter is all you need. I add it as a matter of course, as I 
now have shiny HD LCD monitor, which doesn't show up the flicker, until it gets 
shown on a tube-based monitor or TV set. Yet another reason not to trust your 
computer screen!

The only other minor observation that I can contribute (which may be in the 
manual) is that it seems that if your .PSD is not RGB/8bit, then it will be flattened 
on import, so it is best always to check your Mode when importing stills and 
creating layers in Photoshop (I still use CS2).

Larry replies: Jonathan, thanks for sharing your thoughts. My only comment is that I recommend 
NOT adding any deinterlace or deflicker filters in FCP. 

All standard def formats - both PAL and NTSC, and all HD formats ending in "i" - are interlaced. 
Deinterlacing simply makes your image softer because deinterlacing removes a significant 
amount of vertical image resolution.



As a general rule, the only time you should deinterlace is when you are going to the web. In 
which case, remove the interlacing during compression as it will look better than if Final Cut Pro 
does it.

Don't make any final decisions on adding deflicker filters until you've watched your video on a TV 
monitor, not just the computer monitor. 
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QUESTION FOR READERS

Toby Heslop sent me a question I can't answer:

I would like to see an article about working with the new XDCAM EX cameras and 
how you can hand off your footage correctly to broadcasters or clients who are 
using an AVID system. 

Can AVID users take the .mov files or what do they need and what is the workflow 
we should use!

Larry replies: Toby, I don't know. Maybe a reader can help.
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CREATING LAYERED MENUS IN DVD STUDIO PRO 4

Andrew Cohen writes:

I am trying to import some menu's I made for Encore, into DVD Studio Pro 4 as a 
Layered menu, and I can not find what I am supposed to label the layers so they 
are actionable in DVDSP 4.

Larry replies: First, layered menus need to be Photoshop documents. Second, you need to 
create a layered menu "container" in DVD SP -- this is a separate button on the tool bar, using a 
standard menu won't work.

What you name the layers isn't important, because DVD SP displays all the layer names and 
allows you to select which layer is displayed when a button is rolled over or clicked.

I've created a training video on DVD Studio Pro that you can buy here. Or, you can find the 
details in the DVD SP manual starting on page 323 (Chapter 9).
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MORE ON MS AUDIO

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=60


Peter Tooke writes about an audio format called "Mid-Side Audio":

First, thanks for your helpful site. In particular, while searching for any info on 
using mid side audio (unmatrixed ) in FCP, I came across your audio article on the 
same. It advised using the phase inverter in STP as FCP does not have one. 

But I came across a free plug-in for STP that does the matrixing for you, taking 
your discrete mono mid and side tracks and creating a L/F stereo file. The default 
is a 50/50 mix of the mid and side, but you can vary this to taste. Here is the link to 
Soundhack, and their freesound bundle.

Larry replies: Peter, while the MS Audio format is not one I use, it is nice to know that these tools 
are available. Thanks!
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SOUNDTRACK WASTING SPACE

Drew Reece writes:

I think I may be doing something wrong with my audio sweetening workflow, but I 
cannot figure out any way around it.

When using FCP & Soundtrack Pro I have been using 'send audio project…' for 
the clips that need noise reduction, or tweaking (almost everything). I also include 
the source audio in the Soundtrack project files to avoid messing up the original 
source files.

My problem is that I captured large chunks of a performance (30 minutes or so, 
one part is an hour long) to be able to sync up for using multi cam editing. In my 
FCP timeline I have razored out pauses on on certain clips. When I send to 
Soundtrack I have to send the entire audio for every cut, even though both parts of 
the clip are using the same audio stream. I end up with duplicates of the whole 
source audio for every edit in FCP. 
It seems to be a tremendous waste of space to store a few GB of the same audio. 
It also adds to the length of time t o save and open files.

Is there any way around this? Would making 'sub clips' help?

Larry replies: Soundtrack is starting to require its own newsletter - it has a lot of quirks, though I 
still like the software a great deal and use it every day.

http://www.larryjordan.biz/articles/lj_MS_audio.html
http://www.larryjordan.biz/articles/lj_MS_audio.html
http://www.soundhack.com/freeware.php


Soundtrack always loads the entire clip, not just from the In to the Out. There is no way to 
prevent this -- subclips won't help. 

However, when you send to an audio file project, check the Use Referenced Audio option. This 
will allow you to avoid duplicating your audio files. 

Then, when you save the file, select "Reference audio". This will create a pointer to your source 
audio, without duplicating your source audio.

The advantage to this approach is that your files will avoid wasting space. The disadvantage to 
this approach is that you can only play these files on the system that contains the source audio.

When you export for final output, all your output reference files will be converted to fully self-
contained audio files.
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ANOTHER SOUNDTRACK PRO QUESTION

Alan Day, from Cape Town, South Africa, writes:

I have been experiencing a problem with Soundtrack Pro 2 that all but renders in 
useless to the professional working on projects of a Film / Video nature.

When exporting my final mix as an AIFF file for transfer back to FCP (or wherever) 
Soundtrack Pro seems to randomly lose bits of automation, like it missed a 
keyframe in the "rubberbanding". This usually manifests itself as a sudden jump in 
volume, making the exported file worthless. Anybody else had something like this?

I suspect people working on music mixes will mot experience this problem as 
much as Film / Video engineers due to the fact that there is a lot more 
"ducking" (rubberbanding) employed by the latter.

Pro Tools is too expensive to get to the functionality level of STP2 so I am going to 
look at the Steinberg systems today.

Larry replies: Alan, I don't know. Perhaps another reader will have a suggestion.
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WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week.

�●     Please check out my latest video tutorials. 
�●     Visit our store and buy something nice. 

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/store
mailto:larry@larryjordan.biz?subject=Newsletter comments


[ Click here for a printer-friendly PDF version of this issue. 1.9 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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